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SFC Prep 350 User Guide 

Overview   

This user guide supplied with the SFC Prep 350 Supercritical Fluid Chromatography system 
provides instructions for basic operation of the system.  Safety information is provided in Chapter 
1.  An overview of the hardware and installation requirements is provided in Chapter 2.  Chapters 
3 and 4 contain details about the electrical and plumbing connections, respectively.  Instructions 
for operating the SFC Prep 350 are provided in Chapter 5.  An overview of the method setup for 
the SFC Prep 350 system is provided in Chapter 6.  Chapter 7 provides maintenance procedures. 

This manual should be read in its entirety before operating the SFC Prep 350 system. 

Intended Use 
The SFC Prep 350 system is intended for use by qualified personnel to perform purification of 
organic compounds.  It is designed for continuous use.  The system uses combinations of 
supercritical or liquid carbon dioxide (CO2) and liquid organic modifiers to perform normal phase 
chromatographic separations at the semi-preparative and preparative levels.  Separated 
components are directed to one of multiple collection vessels.  During the collection process, 
gaseous CO2 and organic vapor are separated from residual liquid modifier with dissolved 
compounds.  Only the liquid phase is collected.  The system is optimized to perform multiple 
overlapped or “stacked” injections with coordinated collections rather than single large volume 
injections. 

 

 
WARNING 

The user should be made aware that if the equipment  is 
used in a manner not specified by the manufacturer,  the 
protection provided by the equipment may be impaire d. 
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Using This Manua
This manual contains instructions for the safe operation of the 
supercritical fluid chromatography
instrument and throughout the manual

Icon Definitions  
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Customer Support   
For customer support and field service in North America please contact: 

Customer Support 
Thar Instruments, Inc. 
575 Epsilon Drive, Suite 100 
Pittsburgh, PA 15238   USA 

Telephone 412 967 5665, Option # 4 
412 967 9446 

 service@tharsfc.com 
Internet http://www.tharsfc.com 

Outside of North America, please contact your local service representative. 

Using This Manua l 
contains instructions for the safe operation of the Thar Instruments SFC

chromatography system.  The following icon definitions are used on the 
throughout the manual. 

WARNING Calls attention to a condition or possible situatio n that 
could cause injury to the user. 

VOLTAGE Calls attention to an area of high voltage that could 
cause injury to the user. 

 
Calls attention to a condition or possible situatio n that 
could damage or destroy either the product or the 
user’s work.  

Calls attention to information, which may be 
optimized instrument operation.  
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Chapter 1  
Safety 

Introduction 
This chapter provides important safety information about the Thar Instruments SFC Prep 350 
supercritical fluid chromatography system.  The information and warnings contained in this 
chapter must be followed to properly operate the SFC Prep 350 system in a safe and successful 
manner.  The SFC Prep 350 shipping and storage guidelines, safety features, electrical 
considerations, and operating considerations are provided. 

 
WARNING 

The user should be made aware that if the equipment  is 
used in a manner not specified by the manufacturer,  the 
protection provided by the equipment may be impaire d. 

Declaration of Conformity 
The Declaration of Conformity for each module is located in Appendix V. 

 
WARNING 

Thar Instruments will not accept any liability for damages 
directly or indirectly caused by connecting this in strument 
to devices which do not meet relevant safety standa rds. 
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Shipping and Storage 
The SFC Prep 350 supercritical fluid chromatography system has been designed for indoor use.  
It may be shipped and stored for brief intervals at temperatures between 0 and 55°C (32 – 130°F) 
without degradation of its safe operation.  However, it is recommended that the unit stay within 15 
and 35°C (60 - 95°F) during shipping and storage for optimal performance once installed.  Also 
for optimal performance, relative humidity levels should stay at or below 60%.  

Whenever it is likely that the protective safety mechanisms of the SFC Prep 350 system have 
been impaired due to inappropriate packaging, shipping or misuse, the SFC Prep 350 shall be 
made inoperable and shall be secured against further operation.  Protective safety mechanisms 
are likely to be impaired if, for example, the SFC Prep 350 system: 

• Shows visible damage. 

• Has been subjected to prolonged storage under unfavorable conditions. 

• Has been subjected to severe transport stresses. 

• Exhibits mechanical failure by not performing an intended function. 

 



 
Safety 

 

SFC Prep 350 1-3 Thar Instruments 

Safety Requirements 
Observe all warning labels on the system.  Never remove warning labels.  Do not operate the 
system with damaged or leaking equipment. 

Safety Features 

P-350/200 Pumps 

The pressure rating of the system is adjusted for operation at various pressure and 
temperature conditions.  Normally, the rated operating pressure of the tubing is 6000psi 
and rupture disc is 4800psi  at 23°C (72°F). 

Maximum Pressure Alarm 

The P-350 pump contains a pressure transducer which senses the pressure at the pump 
outlet.  If the pressure exceeds the alarm setpoint, the pump will stop and an audible 
beep will sound to alert the operator.  When the pressure drops below the alarm setpoint, 
the audible alarm will stop.  The pump will not restart automatically. 

Rupture Disc 

The P-350 and P-200 pumps are equipped with a rupture disc which is designed to open, 
burst, if the pressure exceeds the disc limit. 

 

Pressure rating P-350  320bar 

Pressure rating P-200 380bar  

Threaded vessel enclosures 420 bar 

Temperature alarm maximum Heat Exchangers 60C 
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Safety Sensors/Alarms 
Thar recommends the following external sensors/alarms for your SFC system: 

• Carbon dioxide (CO2) sensor and alarm to provide warning for large leaks and possible 
dewar/cylinder malfunctions. 

• Oxygen sensor/alarm to cover carbon dioxide leaks that cause the oxygen level to fall 
below safe levels.  This will also cover nitrogen (N2) leaks from other equipment and N2 
leaks from drying product containers after cleaning. 

• LEL (Lower Explosive Limit) sensor/alarm for accidental spills of co-solvent and/or leaks 
that may contain solvent in an aerosol-like state. 

 

Before proceeding with any monitoring safety configuration, check with your Environmental 
Health and Safety (EHS) Manager regarding applicable local, federal and international safety 
regulations and requirements. 
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Additional Warnings 
 

 
WARNING 

(If applicable) Prior to opening the column oven do or, turn 
off the oven temperature zone.  Co-solvent fluids s uch as 
methanol are moderately flammable.  Leaks, when con fined 
to an enclosed space, may create a fire hazard. 

 

 
WARNING 

(If applicable) When checking fittings for leaks in side the 
column oven to ensure no leakage of flammable fluid s from 
the fittings inside the column oven: 

• Turn off the oven heater. 
• Use 100% CO2 mobile phase 

 

Flammability Warning 

The SFC Prep 350 system has an optional column oven to help maintain the temperature 
stability of the chromatographic separation.  Leaks of flammable mobile phase into this 
oven could cause flammable or explosive mixtures to form.  The oven components can 
achieve temperatures > 180°C.  These temperature le vels exceed the flash point of many 
flammable vapors.  Avoid using any solvent with ignition temperatures in this range.  
Always check for leaks prior to operating the system in an unattended manner. 

 

 
WARNING Thar recommends that you DO NOT use a highly flamma ble 

solvent as any part of the mobile phase. 

 

 

!
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Electrical Considerations
The operating voltage  of your SFC Prep 
the standard voltage for your location.  If the system is moved to an area u
voltage, the system must be reconfigured for the correct voltage.  Contact Thar, or your dealer, 
for information on how to change the operating voltage.

Before powering on the SFC Prep 
an appropriate source of power.
provided with a protective earth (ground) contact.  The protective action of this connection must 
not be negated by the use of an extension cord without a ground conductor.  Any interruption of 
the protective grounding conductor or disconnection of the protective earth ground could cause a 
fault condition that may result in personal injury.  Thar Instruments assumes no responsibility for 
improperly grounded receptacles or power cords provided by t
supply outlet must meet local electrical codes.  Additional details about electrical requirements 
and electrical connections can be found in 

 

The components in the SFC350
changes necessary to switch from 60 to 50 Hz.
frequency specific and should not 

 

 
WARNING

 
VOLTAGE

 

 
WARNING

 
VOLTAGE

 

!
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Electrical Considerations  
of your SFC Prep 350 system was configured at the factory to operate 

voltage for your location.  If the system is moved to an area using a different line 
voltage, the system must be reconfigured for the correct voltage.  Contact Thar, or your dealer, 
for information on how to change the operating voltage. 

the SFC Prep 350 components, ensure that all power cords are
an appropriate source of power.  The power cord should only be inserted into a socket outlet 
provided with a protective earth (ground) contact.  The protective action of this connection must 
not be negated by the use of an extension cord without a ground conductor.  Any interruption of 
he protective grounding conductor or disconnection of the protective earth ground could cause a 
fault condition that may result in personal injury.  Thar Instruments assumes no responsibility for 
improperly grounded receptacles or power cords provided by the end user.  All wiring to the 
supply outlet must meet local electrical codes.  Additional details about electrical requirements 
and electrical connections can be found in Chapters 2 and 3, respectively. 

350 were designed to operate on both 50 and 60 Hz.  There are no 
changes necessary to switch from 60 to 50 Hz.  The waterbath that comes with the system is 

not be used with a different Hz rating until contacting Thar Service.

WARNING 
Improperly gro unded receptacles pose a risk of electrical 
shock. 

VOLTAGE 

WARNING 
Do not operate the system with damaged line cords.

VOLTAGE 
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system was configured at the factory to operate on 
a different line 

voltage, the system must be reconfigured for the correct voltage.  Contact Thar, or your dealer, 

are connected to 
The power cord should only be inserted into a socket outlet 

provided with a protective earth (ground) contact.  The protective action of this connection must 
not be negated by the use of an extension cord without a ground conductor.  Any interruption of 
he protective grounding conductor or disconnection of the protective earth ground could cause a 
fault condition that may result in personal injury.  Thar Instruments assumes no responsibility for 

he end user.  All wiring to the 
supply outlet must meet local electrical codes.  Additional details about electrical requirements 

ate on both 50 and 60 Hz.  There are no 
The waterbath that comes with the system is 

be used with a different Hz rating until contacting Thar Service. 

unded receptacles pose a risk of electrical 

Do not operate the system with damaged line cords.  
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Operating Considerations 
Observe good laboratory practice when using the SFC Prep 350 system.  Always keep in mind 
the following safety practices: 

• Familiarize yourself with proper handling, storage, and disposal of all chemicals used with 
your SFC system.  Refer to the Material Safety Data Sheet (MSDS) for each solvent you 
use, and know its chemical properties. 

• Wear the appropriate personal protective equipment when working with any type of 
hazardous chemical. 

• Wear eye protection while near the instrument to protect eyes from possible failure of 
column seals or fittings. 

• Ensure that the system is depressurized before loosening any fittings in the CO2 flow 
path. 

• Exercise caution when accessing components.  Internal and external surfaces of the 
components can become very hot or very cold during normal operation and direct contact 
could cause injury.  The internal oven compartment is capable of reaching temperatures 
high enough to cause burns and the internal surfaces do not cool instantly upon opening 
the door.  Internal surfaces such as heat sinks, valves, tubing, and fittings may become 
very hot or extremely cold, as low as -40°C. 

 

 
WARNING 

Internal and external surfaces of the components ca n 
become extremely hot or cold during normal operatio n.  
Use caution when accessing any component. 

 

 
WARNING 

The SFC Prep350 System poses a potential rapid 
decompression hazard.  Exposure to rapidly expandin g 
fluids can cause injuries, including frostbite. 

• Exercise caution when opening fittings to prevent 
the possibility of being sprayed by expanding fluid  
or solvents. 

• Always depressurize the system before attempting 
to change or work on the bulk fluid supply. 

• Use only supply lines constructed of the 
appropriate material. 

 

 

!
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Chemical Considerations 

Always practice good chemical hygiene.  Familiarize yourself with proper handling, 
storage, and disposal of all chemicals used with your SFC system.  Refer to the Material 
Safety Data Sheet (MSDS) for each solvent you use, and know its chemical properties. 

Solvents used in the mobile phase should be compatible with the materials in the SFC 
Prep 350 flow path including stainless steel, PEEK, and Teflon®. 

����    CAUTION Thar assumes no responsibility for the use of untes ted or 
undefined fluids. 

 

Bulk Fluids 

A bulk fluid is a fluid that makes up more than 50% of the mobile phase.  Carbon dioxide 
is the only  fluid recommended for use as a bulk fluid in the SFC Prep 350 system. 

 

 
WARNING 

Carbon dioxide exhibits three primary hazards for h umans: 
• Toxicity at levels above 10,000 ppm (PEL 

5000 ppm). 

• Frostbite from uncontrolled release of pressurized 
CO2 to atmosphere or contact with accumulated 
dry ice at a leak site. 

• Asphyxiation due to displacement of oxygen. 

 

As noted previously (see External CO2 Monitoring, p. 1-4), Thar recommends installation 
of a CO2 Ambient Air Sensor/Alarm unit (P/N 16001267) to ensure compliance with 
OSHA PEL for CO2 in locations where CO2 is used or stored.  This is instead of, or in 
addition to, an oxygen monitor.  Monitors purchased from an alternate source should be 
capable of detecting CO2 levels to 10,000 ppm and provide an alarm at 5000 ppm. 

 

!
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Co-Solvents 

Packed column SFC is a form of normal phase chromatography where the easiest-to-
elute solutes are the most nonpolar.  Pure fluids like carbon dioxide are poor solvents for 
polar solutes.  To increase the range of solutes amenable to SFC, a more polar co-
solvent or modifier is added to the mobile phase.  Most organic solvents are viable co-
solvents for packed column SFC.  Few organic solvents are corrosive or detrimental to 
the components of the SFC Prep 350 system.  However, several relatively nonpolar 
solvents corrode stainless steel, which is the recommended material for the majority of 
tubing in the SFC Prep 350 system.  Methylene chloride (dichloromethane) is one such 
corrosive nonpolar solvent that is NOT recommended for use in the SFC Prep 350 
system. 

The most commonly used co-solvent in the SFC Prep 350 system is methanol.  Methanol 
is a more polar solvent that is completely miscible with carbon dioxide. 

 

����    CAUTION 
Always check the compatibility of the organic modif ier with 
the column phase in use.  Some column phases will b e 
destroyed with improper selection of co-solvent. 

 

Recommended Co-Solvents 

Co-solvents recommended for use in the SFC Prep 350 system are listed in Table 1-1 
(below).  

Table 1-1 Recommended Co-Solvents 

Acetonitrile Hexane 

Chloroform Isopropyl alcohol 

Ethanol Methanol 
 

In infrequent cases, the co-solvent composition may exceed 50% of the mobile phase 
composition.  Moving significantly above this composition can rapidly decrease the 
advantage of CO2 based separations.  Whenever possible, users should attempt to stay 
below 50% co-solvent composition. 

 

 
WARNING The recommended modifiers are Class 1B flammable 

materials. 
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Additives 

The peaks of very polar solutes often tail.  If for process reasons it’s necessary to 
improve peak shape, a third component, an additive can be added to the mobile phase.  
Additives are usually too polar for direct addition to carbon dioxide alone.  The additive is 
generally added to the co-solvent at a concentration of less than 1% of the co-solvent 
composition.  The co-solvent and additive are then pumped together and mixed with the 
bulk fluid. 

 

����    CAUTION Some additives can be corrosive to columns and the 
column manufacturer’s guidelines must be followed. 

 

 
WARNING 

Most additives are strong acids or strong bases.  
• Wear appropriate personal protective equipment 

(PPE) when handling them. 
• Ensure that proper safety equipment is available 

including an eyewash station and a safety shower. 

 

Acceptable Additives 

Table 1-2 lists acceptable additives for use in the SFC Prep350 system. 

Table 1-2 Acceptable Additives 

Acetic acid Triethylamine 

Trichloroacetic acid Dimethyl ethyl amine 

Trifluroacetic acid Propylamine 

Citric acid Isopropylamine 

Dimethylamine Ammonium acetate 

Trimethylamine  
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Fluids Not Recommended 

While this list is not complete, the fluids listed in Table 1-3 are neither recommended nor 
supported as bulk fluids or co-solvents in the SFC Prep 350 system. 

 

Table 1-3 Fluids not Recommended 

Ammonia Dimethyl ether 

Benzene Dimethyl sulfoxide 

Brominated solvents Ethane 

Butane Ethylene 

Carbon disulfide Methylamine 

Chlorinated solvents Methylene chloride 

Chloroform Methyl t-butyl ether 

Diethyl ether Nitrous oxide 

Di-isopropyl ether Propane 

Dimethyl acetamide  

Aqua regia Bromine 

Chlorine anhydrous Copper chloride 

Ferric chloride Ferrous chloride 

Freon 12 Guanidine 

Hydrobromic acid Hydrochloric acid 

Hydrofluoric acid Hydrofluorsilicic acid 

Hydrogen peroxide Iodine 

Mercuric chloride  

 

Circulating Bath 
Never operate the circulating bath without coolant in the bath.  The minimum requirement is a 
50/50 mixture of ethylene glycol and water as coolant 
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Collection Container Requirements 
Thar supplies pressure-rated 2 liter bottles with specially designed caps for collection and 
waste.  The bottles are rated for 0.4 bar and the caps are designed to allow CO2 venting 
to avoid a pressure buildup in the bottle.   

Use of different size collection containers requires prior consultation with your Thar 
representative.   

 
WARNING Always inspect glassware for any visible damage or defects 

prior to use. 

 

 

 
WARNING The CO2 supply cylinder should be secured with safety 

strapping prior to connecting to the system. 

 

 

 

 

 

  

!
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Chapter 2  
Hardware Overview 

Introduction 
This chapter provides an overview of the SFC Prep 350 hardware and installation site 
requirements.  Detailed information about communication, electrical and plumbing connections is 
provided in later chapters. 

SFC Prep 350 System Components 
The SFC Prep 350 System contains the following components: 

• System Overview (Pre-collection): 

� High pressure CO2 pump 

� Cooling heat exchanger and circulating bath 

� Mass flow meter 

� High pressure co-solvent pump 

� High pressure static mixer 

� Pre-column heat exchanger 

� High pressure valve 

� Injection module 

� Automated back pressure regulator (ABPR) 

� Trailing heat exchanger 

• System Overview (Post Collection) 

� High pressure fraction collection module 

� Fraction Collectors 

� Manual back pressure regulator (MBPR) 

� Fraction Collection Bottles with custom designed venting caps 

• Control system and software: 

� PC with keyboard, mouse and multi-port  Rocketport or RS-232 card 

� LCD monitor 

� Pre-loaded and configured SuperChrom software package  
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Figure 2-1 SFC Prep 350 System 
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CO2 Pump 
The CO2 high pressure pump provides efficient pumping of CO2 by incorporating low dead 
volume head and self priming check valves. 

 

Figure 2-2 CO 2 Pump 
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Cooling Heat Exchanger and Circulating Bath 
The heat exchanger is used to cool and liquefy CO2 before it enters the CO2 pump.  The cooling 
bath circulates coolant through the pump heads and cooling heat exchanger (HE1). 

Mass Flow Meter 
The mass flow meter measures the liquefied carbon dioxide mass output from the CO2 pump.  
The feedback from the Mass Flow Meter helps control the pump and maintain an accurate and 
consistent CO2 flow rate. 

Co-Solvent Pump 
The co-solvent or modifier pump is calibrated to deliver a consistent amount of liquid in the 
specified operating range of the SFC Prep350 

Static Mixer 
The high pressure static mixer blends the CO2 and co-solvent flow streams. 

Injection Module 
The injection module introduces the sample to the injection valve.  Two injection configurations 
are available (1) modifier stream injection and (2) combined stream injection.  Plumbing 
connections for each configuration are provided in Chapter 4. 

UV Detector 
The UV detector is a variable wavelength detector.  The peak detector uses the output from the 
UV detector to trigger fraction collection. 

Fraction Collection Module 
The fraction collection module uses two high pressure rotary valves to allow collection of up to 12 
compound fractions.  
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Installation Requirements 
Work space requirements are provided in Table 2-1.  The SFC Prep 350 system should installed 
at a comfortable operating height.  Space on the front and sides of the system should be 
available to access components. 

The water bath should be placed on the floor next to the SFC Prep 350 system.  The water bath 
requires ventilation for proper operation.  Position the water bath to not impede air intake and 
discharge. 

Work Space Specifications  

Work space requirements are summarized in Table 2-1 and Figure 2-1 (next page). 

Table 2-1 Work Space Requirements 

Factor Requirement 

Workspace 

System 

Width: 107 cm (42 inch) 
Depth: 92 cm (36 inch) 
Height: 135 cm (53 inch) 
Weight: 123 kg (270 lb) 

Water Bath (Floor) 

Width: 40 cm (16 in) 

Depth: 43 cm (17 in) 

Height: 63 cm (25 in) 

Weight: 65 kg (145 lb) 

Computer 

Width: 16.8 cm (6.6 in) 

Depth: 45.0 cm (17.7 in) 

Height: 45.6 cm (17.9 in) 

Weight: 16 kg (35 lb) 

Computer Monitor 
(with stand) 

Width: 44.6 cm (17.6 in) 

Depth: 18.7 cm (7.3 in) 

Height: 37.0 cm (14.6 in) 

Weight: 5 kg (11 lb) 

Clearance* 

System 

Front:  

Rear: 15 cm (6 in) 

Right side:  

Left side:  

Top:  

Water Bath (Floor) 

Front: 10 cm (4 in) 

Rear: 10 cm (4 in) 

Right side: 10 cm (4 in) 

Left side: 10 cm (4 in) 

Top: 10 cm (4 in) 

*Additional clearance of 60 cm (24 in) to the left of the unit is recommended for installation 
purposes.  This additional space is not required once the system is installed. 
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Figure 2-3 SFC350 System Layout 
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Customer Supplied Materials 

To perform an installation of the SFC Prep 350 system the user must provide the 
materials listed in Table 2-2. 

Table 2-2 Customer Supplied Materials 

Material Comments 

3 cylinders of CO2 with dip tube Minimum required for system checkout 

13-liter supply of 50% ethylene glycol and water Required for the cooling bath operation 

8-liter supply of co-solvent Minimum required for system checkout 

Sample in sufficient quantity for testing Minimum required for system checkout 

  

Ventilation tubing 1/4“ compression fitting 

  

Column min 3 or 5 cm diameter For testing 

Completed site prep checklist See SFC350 Site Preparation Instruction and 
Installation Procedures (MN50)  
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Electrical Requirements
Grounding and power supply requirements for the SFC Prep 

Grounding 

When plugged into a properly wired receptacle, the three
both power to and grounding of the instrument.  Proper 
periodically verified.  Any interruption of the protective grounding conductor, or 
disconnection of the protective earth ground, could cause a fault condition that may result 
in personal injury.  Thar assumes no responsibilit
or power cords provided by the end user.

 

 
WARNING

 
VOLTAGE

 

Power Supply Requirements

The SFC Prep 350 system is configured at the factory for the power ordered.  
supply requirements are summarized in Table 2
Chapter 1 for additional details.

Table 

System  System 
Current/Plugs

120 VAC 28 Amp (total)/
2 ea L5-20 plug

220 VAC 18 Amp (total)/
2 ea CEE-7 plug

*The water bath should be on its own circuit.

!
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Electrical Requirements  
Grounding and power supply requirements for the SFC Prep 350 are provided below.

When plugged into a properly wired receptacle, the three-conductor power line provides 
both power to and grounding of the instrument.  Proper receptacle grounding should be 
periodically verified.  Any interruption of the protective grounding conductor, or 
disconnection of the protective earth ground, could cause a fault condition that may result 
in personal injury.  Thar assumes no responsibility for improperly grounded receptacles 
or power cords provided by the end user. 

WARNING 
Improperly grounded receptacles pose a risk of elec trical 
shock. 

VOLTAGE 

Requirements  

system is configured at the factory for the power ordered.  
ents are summarized in Table 2-3.  Refer to “Electrical Considerations” in 

Chapter 1 for additional details. 

Table 2-3 Power Supply Requirements 

Current/Plugs  
Water Bath* 
Current/Plugs 

Computer 
Current/Plugs 

Monitor 
Current/Plugs

28 Amp (total)/ 
20 plug 

14 Amp/ 
1 ea 5-15 plug 

1.1 Amp/ 
1 ea 5-15 plug 

.9 Amp/
1 ea 5

18 Amp (total)/ 
7 plug 

7 Amp/ 
1 ea CEE-7 plug 

1.1 Amp/ 
1 ea CEE-7 plug 

.9 Amp/
1 ea CEE

ater bath should be on its own circuit. 
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are provided below. 

conductor power line provides 
receptacle grounding should be 

periodically verified.  Any interruption of the protective grounding conductor, or 
disconnection of the protective earth ground, could cause a fault condition that may result 

y for improperly grounded receptacles 

Improperly grounded receptacles pose a risk of elec trical 

system is configured at the factory for the power ordered.  Power 
.  Refer to “Electrical Considerations” in 

Monitor 
Current/Plugs  

.9 Amp/ 
1 ea 5-15 plug 

.9 Amp/ 
1 ea CEE-7 plug 
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Required power cords are supplied with the system.  Plugs for North American (NA) and 
European installations are shown in Figure 2-4. 

 

NA Style Plugs 110 VAC   European Style Plug 220 VAC  

 
 

 

 

NEMA L5-20P NEMA 5-15P  CEE-7 

Figure 2-4 NA and European Style Plugs 

 
NA Style Plugs 220 VAC 
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Chemical Requirements 
Solvents used in the mobile phase should be compatible with the materials in the SFC Prep 350 
flow path including stainless steel, PEEK, and Teflon. 

Carbon Dioxide 

Carbon dioxide is the only bulk fluid Thar Instruments recommends for use in the SFC 
Prep 350 system.  CO2 requirements are summarized in Table 2-4.  CO2 purity should be 
industrial grade or better depending on your application requirements.  The CO2 supply 
tank must have a dip tube to pull liquid CO2 from the bottom of the tank.  Use of low 
pressure tanks such as dewars, is not acceptable.  Tank must be capable of delivering a 
minimum of 50 bar.  Tanks should not be stored in cold locations. 

Table 2-4 CO 2 Requirements 

Purity Industrial grade or better 

Supply cylinder Dip tube cylinder 

Pressure Minimum 50 bar 

Storage temperature Ambient 

 

Co-Solvents 

Co-solvents or modifiers are organic solvents used as a component of the SFC mobile 
phase.  They are required for proper SFC fraction collection.  Co-solvents should be 
HPLC grade or reagent grade. 

In most cases, preparative SFC uses UV-Vis detectors; consider this when selecting an 
appropriate co-solvent.  Refer to Chapter 1, “Safety” for recommended co-solvents and 
solvents to avoid. 
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Plumbing Requirements 
 

����    CAUTION 
Particulate matter should not be introduced to the pump or 
damage to the check valve sealing surface may resul t.  A 
filter should be placed directly upstream of the pu mp to 
capture any solids that may have formed. 

 

Venting Requirements 

Ventilation is required for the SFC Prep 350.  The SFC Prep 350 provides provisions for 
venting to a fume hood to the outside through a 1/4" compression fitting.  Tubing 
connected to the fitting should be of sufficient strength to withstand the pressures.  If the 
run is going to be greater than 5 feet or contain multiple bends larger tubing should be 
used to prevent restriction of the escaping gasses 

 

 
WARNING Venting of the SFC Prep 350 is the sole responsibil ity of the 

end user. 

 

 

!
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Chapter 3  
Electrical Connections 

Introduction 
There are two types of electrical connections required to configure your SFC Prep 350 system:  
communication (Rocketport or RS-232 serial) and power cords. 

Communication 
Communication between modules and the PC is via Rocketport (or RS-232) serial and USB 
connections.  All necessary cables are provided with the system. 

Communication Cable Connections 
Directions for connecting the communication cables for your SFC Prep 350 system are provided 
below. 

����    CAUTION Failure to make the proper connections will result in a loss 
of communication with the device. 

 

1. Turn on the computer and allow it to complete initialization. 

2. Connect the USB cable from the Peak Detector (Analog to Digital converter) to the 
computer USB port labeled Peak Detector.  Connect the Rocketport to the computer.  If 
the USB ports are not labeled, plug the cable into the first port.  If you receive a message 
“Found New Hardware”, unplug the cable and cancel the hardware installation. 

 

����    CAUTION 
Do NOT allow Windows to install the USB/RS-232 conv erter 
or the Peak Detector.  The required software was in stalled 
at the factory. 

 

3. Connect the USB cable from the analog interface card to the computer USB port labeled 
Peak Detector.  If the ports are not labeled, plug the cable into the first port.  If you 
receive a message “Found New Hardware”, unplug the cable and cancel the hardware 
installation.  Repeat the process in the next USB port. 
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4. All of the individual component connections between the converter and the unit will be 
already made.  These connections listed below for reference only: 

Table 3-1 Serial Connections 

RS-232 Hub To System 

COM 1 P1 (Pump 1) 

COM 2 ABPR1 

COM 3 P2 (Pump 2) 

COM 4 CN6 

COM 5 UV detector 

COM 6 Level Controller  

COM 7 Injection module 

COM 8 Collection module 
 

Power Connections 
Each module contains its own internal power supply.  The system power connections should be 
connected to an appropriate power source.  If applicable the power switches are located on the 
rear of each module.  For additional information about power requirements refer to Chapter 2. 
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Chapter 4  
Plumbing Connections 

Introduction 
This chapter provides 

All required tubing is supplied with the system. 

Pump Cooling Tubing 

Thar CO2 pumps require external cooling of the CO2 for proper operation.  Improper 
cooling of the pump heads and CO2 will cause inefficient pump operation.  The 
connection between the outlet of the pump heads cooling tubes and the inlet to the 
cooling heat exchanger will already be made. 

1. Locate the “Outlet” port on the bath and slide the 5/16” ID Silastic Tubing (02321) 
from the HE1 inlet over the end of the fitting.  The entire barbed section of the 
fitting must be covered or the tube may come off. 

2. Locate the “Inlet” port on the water bath and slide the 5/16” ID Silastic Tubing 
(02321) from the CO2 pump heads over the end of the fitting.  The entire barbed 
section of the fitting must be covered or the tube may come off. 

3. Fill the bath reservoir with a 50/50 mixture of antifreeze and water.  Follow the 
antifreeze manufacturer’s recommendations to allow for a temperature of –20°C.   

4. Turn on the bath and set the control temperature to 3°C. 
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External CO 2 Connections 
1. Secure the CO2 supply cylinder with safety strapping. 

 

 
WARNING Secure the CO 2 cylinder with safety strapping. 

 

2. Remove the cap and protective wrap from the tank valve. 

3. Point the valve outlet away from all personnel and “burp” the cylinder for 2-3 seconds 
until liquid escapes.  To “burp” the cylinder, open and close the valve in a fast, smooth 
motion.  Wipe the valve clean and dry with a lint-free cloth. 

4. Attach the inlet tubing assembly (05132) to the nozzle (ensure the Teflon disc seal is 
inserted into the CGA fitting prior to attaching); use a 1 1/8" open-end wrench to tighten. 

����    NOTE 
The system is shipped with a CGA-320 fitting to con nect to 
the CO2 tank.  Contact your gas supplier to determine if t his 
is the standard connection for your area. 

 

5. Uncoil the tubing toward the rear of the system.  Locate the CO2 inlet fitting on the bottom 
shelf of the system and using a 9/16” backup wrench and 3/8” wrench connect the tubing 
to the fitting. 

 
Figure 4-1 CO 2 Tank Fitting 
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Chapter 5  
Operating the SFC Prep 350 

Introduction 
This chapter provides basic instructions for operating your SFC Prep 350.  For information on 
method setup refer to Chapter 6. 

 
WARNING 

The user should be made aware that if the equipment  is 
used in a manner not specified by the manufacturer,  the 
protection provided by the equipment may be impaire d. 

 

System Startup 
A summary of the recommended startup procedure for the SFC Prep 350 system is provided 
below. 

1. Power on the system 

2. Verify water bath temperature 

3. Inspect collection bottles and vessels 

4. Start SuperChrom 

5. Setup UV detector* 

6. Prime the co-solvent pump 

7. Install/replace column 

8. Turn on the CO2 supply 

9. Prime the injection module 

10. Set the manual BPR pressure 

11. Setup the Level Controller 

*UV detector setup only required for initial system startup. 

 

!
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Power on the System 
1. Ensure the computer and system are connected up to the correct power supply.  Power 

on all of the components, including the PC and monitor.  Note:  Power switches are 
located on the rear of each SFC Prep 350 module. 

2. Verify that all of the units are powered on. 

3. Perform a normal Windows OS startup on the computer. 

Verify Water Bath Temperature 
Confirm the water bath temperature is set to 3°C. 

Inspect Collection Bottles and Vessels 
Inspect the collection bottles and vessels.  

Collection Bottles 

Fractions must be collected into suitable containers.  Your system was shipped with 2L 
collection bottles for each cyclone including the waste cyclone.  The bottles are rated for 
0.4 bar of pressure and have custom designed caps that allow CO2 to vent while avoiding 
a pressure buildup in the bottle. 

Use of different size bottles requires prior notification to Thar.  Depending of the version 
of caps that were delivered with your system there may be some modifications necessary 
to allow use of smaller bottles and maintain the large safety factor that Thar requires. 

1. Inspect the vessels for defects. 

2. Ensure the collection bottles are empty and clean before use.  Inspect the 
vessels for buildup of solid material. 

3. Replace any defective or unclean container. 

4. Ensure the caps are tight on each container. 
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Open SuperChrom Software 
1. Double click the SuperChrom icon on the desktop. 

 

2. The User Login window displays.  Click in the Login field; enter your Login and Password.  
Then click the Login  button. 

 

Figure 5-1 SuperChrom Login Window 

 

����    NOTE The Login and Password fields are case sensitive. 
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3. The SuperChrom software should open after (at most) a minute of communication with 
the system. 

 
Figure 5-2 SuperChrom Main Screen 
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UV Detector Setup 
1. Turn on the UV lamp and allow the detector to complete the wavelength validation 

process. 

2. Press Mode  on the UV detector touch screen display. 

 
Figure 5-3 Select Mode 

3. Then press Setup . 

 
Figure 5-4 Select Setup 
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4. Confirm the Channel 1 signal is set to 100 mVFS. 

 
Figure 5-5 Set Channel 1 

5. Press Next .  Ensure both lamp alarms are set to 0. 

 
Figure 5-6 UV Lamp Alarms 
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6. Press Next .  Confirm the Autorange multiplier is set to 0.2 and all others are zero 

 
Figure 5-7 Set Autorange Multiplier 

7. Press Next .  Confirm the Concentration factor is set to 1.000. 

 
Figure 5-8 Set Concentration Factor 

8. Press the ESC (Escape) button. 



 
Operating the SFC Prep 350 

 

SFC Prep 350 5-8 Thar Instruments 

9. In the SuperChrom main window, right-click on the detector and select Detector 
Settings . 

 
Figure 5-9 Detector Settings 

 

����    NOTE Alternatively, the UV Detector settings can be acce ssed by 
selecting View > UV Detector Settings. 

 

10. The UV Detector Settings screen displays. 

 
Figure 5-10 UV Detector Settings 
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11. Set the following: 

UV wavelength 230 nm 

Sensitivity 1 & 2 0.01 AUFS 

Peak width 5.0 sec 
 

12. Click Apply Changes . 

13. Click OK to close the UV Dectector Settings screen and return to the main SuperChrom 
screen. 

14. Double-click the Detector icon to open the UV Input screen. 

15. Confirm the “Show Injection/Collection Marks” box is checked. 

 
Figure 5-11 Injection/Collection Marks 

16. Optional settings (not recommended for Stacked Injections).  Checking the box activates 
the option: 

a. Display Elapsed Time - Displays the elapsed time instead of the actual time. 

b. Zero Time On Inject – Zeroes the time upon injection. 

c. Zero Detector On Inject - Zeroes the detector upon injection. 
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Prime the Co-Solvent (Modifier) Pump 
The co-solvent pump lines must be primed for proper operation.  The co-solvent reservoir should 
be covered and placed at the same level or slightly higher than the pump. 

����    CAUTION Do NOT pump the co-solvent up from floor level. 

 

Follow the steps below to prime the solvent lines. 

1. Place the filtered inlet line into the co-solvent reservoir.  The entire filter must be 
immersed in the co-solvent. 

2. Place a waste collection container at the end of the priming line to collect the solvent 
waste. 

3. Close the MV1 valve which leads to the system and open the MV1 valve that leads to the 
priming line. 

 
WARNING 

One side of MV1 MUST always be left open when the p ump 
is running.  Closing both sides of MV1 while the pu mp is 
running will cause the pump rupture disc to burst. 

 

 
WARNING Open the priming valve slowly.  If there is any pre ssure in 

the system, it will bleed out through the valve. 

 

 

Figure 5-12 MV1 

!

!

MV1 

Valve to system 

Valve for 
Priming 
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4. In the SuperChrom main screen, right-click on the Co-Solvent pump icon and select Co-
Solvent Pump Display . 

 
Figure 5-13 Co-Solvent Pump Display 

5. In the Co-Solvent Pump display window click Device Settings . 
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Figure 5-14 Co-Solvent Pump Settings 

6. Enter a Flow Rate of 30 g/min. 

7. Click Apply .  Then click OK to close the pump settings window and return to the co-
solvent pump display window. 
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Figure 5-15 Start Pump 

8. Click the Start Pump  button. 

9. Allow flow to continue until you observe no visible air bubbles in the outlet line. 

10. Then click the Stop Pump  button. 

11. After the pump stops, close the Priming side of MV1 and open the System side of MV1. 
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Install/Replace Column 
The SFC Prep 350 is equipped with 1/16” fitting that will fit standard chromatography columns.  
Before installing a column confirm that the column is rated for SFC conditions and/or the system 
operational conditions. 

Columns should be installed or replaced with the instrument depressurized, no flow through the 
system, and (if applicable) the oven powered off. 

 

����    CAUTION Never crack the column inlet with liquid CO 2 in the system.  
This could destroy the column. 
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Depressurize the System 

If there IS pressure on the system: 

1. Close MV2. 

 

NOTE: newer systems may have the MV2 in a different location 

  

MV2 located beside 
HE2 

MV2 located beside 
Inj Module 
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2. Right-click on the Automated BPR (ABPR) icon and select ABPR Settings . 

 
Figure 5-16 ABPR Settings 

3. Change the ABPR Pressure Set Point to 0 bar. 

 
Figure 5-17 Pressure Regulator Settings 

4. Click Apply  and then click OK.  Wait for the system to depressurize. 

5. Slowly loosen the lines from the 1/16”union or the column.  Allow these lines to 
vent fully. 
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Install the Column 

When the system is depressurized: 

1. Disconnect the lines from the 1/16” union or column. 

2. Connect the line coming up from the Injection Module to the inlet of the column. 

3. Connect the line going to the UV detector to the outlet of the column. 

4. Open MV2 and check for leaks at the column fittings. 

  

NOTE: newer systems may have the MV2 in a different location 

 

Figure 5-18 MV2 

MV2 located beside 
HE2 

MV2 located beside 
Inj Module 
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 Turn on the CO 2 Supply 
Use a soap solution or a designated leak check solution to check for leaks once the 
CO2 has been turned on near: 

1. The column fittings 

2. The injection module fittings 

3. Check any fitting that has frost around it-which is indicative of a leak 
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Injection Module Settings 
1. Double-click the Injection Module icon on the main SuperChrom screen to open the Thar 

Injection Module window. 

 

����    NOTE 
Alternatively, the Thar Injection Module window can  be 
accessed by either: 
• Selecting View > Thar Injection Module. 
• Or by double clicking the UV detector icon and then  

clicking the Inj. Settings button on the UV Input s creen. 

 

 
Figure 5-19 Thar Injection Module 

2. Verify the sample loop size installed (5 mL loop is standard) matches the entry for 
“Sample Loop Size.” 
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Sample Connection Size 

The sample connection size (i.e. Sample Conn. Size) will vary slightly with each sample 
and sample solvent.  The actual volume of the tubes and valves that make up the sample 
connection size is 95.7 µL.  A safe setting would be between 0.10 mL and 0.15 mL.  With 
some samples and solvents such as acetonitrile, the settings have been as high as 
0.22 mL. 

Injection Module Priming- (mixed phase injections only)  
3. Place the solvent inlet line into a vessel containing rinse solvent. 

4. Place both waste lines in a waste container.  

5. Place the sample line into a vessel containing rinse solvent. 

6. Select View > Thar Injection Module to open the injection module window. 

7. When the syringe and the rest of the system have been properly primed, place the 
sample inlet line in the vessel containing rinse solvent.   

8. If the Injection Module was not cleaned after its last use, remove the sample line from the 
rinse solvent, and place it in a separate waste container. 

9. Click "Perform Wash" of sample line - remember the wash solvent comes through the 
sample line. 
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Injection Module Startup-( mixed phase only)  

1. Make sure the Solvent line to the syringe is submerged in methanol. 

2. Click Prime syringe   

3. Place the sample line into a separate methanol container at the same height as 
the actual sample container. 

4. Click Prime Sample Tubing  

5. (while the system is running) Perform two 5 mL methanol injections at the same 
settings as the actual injections will be (30 sec duration, pushback value, speed, 
etc.) 

6. When the two injections are complete, place the sample line into the desired 
sample solution. 

7. Click Prime Sample Tubing  (there may be a small amount of sample loss here). 

 

����    CAUTION 
Do not perform test injections of less than 1 mL if  you are 
doing a campaign of injections that are greater tha n 1 mL. 
Going from 1 mL to 5 mL injection on a 5 mL loop is  
acceptable. 

 

����    NOTE 
Doing a 0.25 mL injection and then going to a 5 mL injection 
volume will allow some sample into the buffer line for the 
1st injection after the 0.25 mL test injection.  Af ter the first 
5 mL injection, the injection module will work corr ectly 
again. 

 

Injection Module Priming- (modifier stream injections only)  
8. Make sure the Solvent line to the syringe is submerged in methanol. 

9. Click Prime syringe   

10. Click Prime Sample Tubing  

11. Make sure the Enable Prime Before Inject box is checked 
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Set the Manual BPR 
The Manual BPR sets the pressure on the Fraction Collection Vessels.  If the fraction 
collection vessels do not have pressure, the product will be lost.  Follow the directions to 
set the MBPR installed on your system. 

You must have 55 bar back pressure on the 1000 mL cyclones during collection. 

High Pressure MBPR Instructions 

Set the MBPR after 5 minutes of equilibration time at running conditions. 

 

����    CAUTION 
For optimum performance there must be at least 55 b ar of 
manual back pressure on the 1000 mL cyclones during  
collection. 

 

 
Figure 5-20 MBPR valve 

This MBPR must be set to 55 bar to achieve optimum conditions.  This will allow for a 
constant minimum 55 bar back pressure on the 1000 mL cyclones while in operation to 
achieve optimum collection conditions. 

 

The most important pressure regarding the MBPR is the pressure on the cyclones while 
collecting, trying to use 0bar on the cyclones will lead to pro duct loss.  
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Collection Vessels 
When the system is at pressure, check the needle valves of each cyclone 

 

Manually close all the needle valves on each cyclone  
 

 

Figure 5-21 Cyclone Needle Valves 
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Turn On each Fraction Collection cyclone valve from the “UV Input” 
Screen to pressure check each one. 
 

 

Figure 5-22 Manual Collection Switches 

 

As each Collector is selected, make sure the Pressure is increasing in the 
correct fraction collector (FC) 
 
Allow each Cyclone Collector to reach 55-60bar 

On the main Superchrom screen Click the “STOP ALL”  
before continuing to the next step 
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For each cyclone  
open each “Cyclone Drain” solenoid valve manually (green switches)  
 

 

Figure 5-23 Manual Cyclone Drain Switches 

Very slowly start opening each needle valve into each designated 
fraction collection container until CO2 is observed venting into each 
bottle. 
 

 

Figure 5-24 1L Cyclone Needle Valve 

When needle valve is set, turn off each “Cyclone Drain” solenoid valve 
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When each needle is set Start the Method and again allow to equilibrate for 2-
5 minutes after the desired pressure is reached. 

 
Click on “View” then Click on “Level Controller” to use the software’s manual 
drain function. 
 

 

Set Level Controller Drain Levels 
Set all Levels to drain between 15-20mL  
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Shutdown Instructions 
Shutdown instructions for short term (e.g. weekend) and long term are provided below. 

Short Term Shutdown 

Short term shutdown is appropriate for intervals of a few days, e.g. a weekend. 

1. Clean the system of residual product. 

2. Perform a wash on the injection module with methanol. 

3. Turn off the UV detector. 

4. Turn off the CO2 supply. 

5. Leave system pressurized. 

6. Cleaning solvents listed in the acceptable solvents list may remain in the cyclone.  
Solvents listed in the unacceptable solvents list and any other material not on the 
acceptable list should not be left in the cyclone. 

Acceptable Solvents 

• Methanol (MeOH) • Hexane 

• Ethanol • Isopropyl alcohol (IPA) 

• Heptane  
 

Unacceptable Solvents 

• Acetonitrile • Tetrahydrofuran (THF) 

• DMSO • Triethanolamine (TEA) 

• Methylene chloride • Trifluoroacetic acid (TFA) 
 

7. Turn off the water baths for pumps. 



 
Operating the SFC Prep 350 

 

SFC Prep 350 5-28 Thar Instruments 

Long Term Shutdown 

1. Clean the system of residual product. 

a. Perform a wash on the Injection Module with methanol. 

b. If each cyclone has not been cleaned with an acceptable solvent (see 
previous page), execute the “Cleaning Instructions” with either methanol 
(MeOH) or isopropyl alcohol (IPA). 

2. Make sure each cyclone is drained, including the waste cyclone. 

3. Pump pure CO2 through the system for 10 - 15 minutes. 

4. Turn off the CO2. 

5. Depressurize the system. 

6. Close each cyclone fully. 

7. Log out of SuperChrom. 

8. Shut down computer. 

9. Power down each component. (Including the water bath) 

10. Disconnect power to the system. 
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Chapter 6  
Method Setup Overview 

Introduction 
This chapter provides basic instructions for method setup for the SFC Prep 350 system. 

Method Settings 
1. In the main SuperChrom screen, click the Method Settings  button. 

 
Figure 6-1 Click Method Settings 
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2. The System Settings window displays. 

 
Figure 6-2 System Run Mode 

3. Select the System Run Mode  tab. 

4. Enable “Run By System Settings”. 
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5. Select the Pressures  tab. 

 
Figure 6-3 Pressures 

6. Enter a value between 100 and 300 bar for the System Back Pressure. 

 

����    NOTE The system back pressure can be set as high as 300 bar. 

 

 
WARNING 

Ensure the column hardware and/or packing material 
installed on the system can handle the “System Back  
Pressure” set point plus an additional 80 bar due t o 
potential back pressure due to the column packing. 

 

!
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7. Select the Pumping  tab. 

 
Figure 6-4 Pumping 

8. Enter 40.0 g/min for the Total Flow. 

9. Enter 15% for the Co-solvent (modifier) Percentage. 
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10. Select the Collection  tab. 

 
Figure 6-5 Collection 

 

11. For test injections do not check “Auto Collection On”.  If you want to collect test injection 
fractions, use the manual collection feature or (if the sample has minimal impurities) mV 
signal for collection. 
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12. Select the Temperature  tab. 

 
Figure 6-6 Temperature 

13. Set the Column Temperature to 35°C. 

14. Click Done  to close this window. 
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Data File Settings 
There are several options for data file storage.  A data file can be created  

• For each injection (recommended), 

• For an entire sequence, or 

• When collection operations start. 

Directions for selecting data file options are provided below. 

1. To access the Data File settings, select Tools > Data File > Log Settings. 

 
Figure 6-7 Data File Log Settings 

 

����    NOTE 
Alternatively, the Data File Settings can be access ed by 
double-clicking the UV detector icon and then click ing the 
Data File Settings button on the UV Input screen. 
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2. Select the General tab: 

 
Figure 6-8 Chromatography Log Settings 

3. Enable “Auto Name Log”. 

4. Select “Start Log When an Injection is made” (recommended). 

 

Other Options 

You have the option to store an entire sequence as a data file or just when the collection 
operations start. 

1. In the menu bar select Tools > Data File > Log Settings. 

2. In the “General” tab check “Auto Name Log” and select “Start Log With Collection 
Process” or select “Start Log When Sequence Starts”  

One of the disadvantages to storing entire sequences and/or collection processes as a 
single log is that RSD% information (especially for retention time) is more difficult or 
nearly impossible to compile. 
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Method Startup 
1. Turn on the CO2 supply. 

2. Allow 2-5 minutes for flow surge to equilibrate. 

3. If the co-solvent pump has not been primed review Prime Co-Solvent Pump. 

4. Confirm MV2 is open (see Figure 5-23). 

5. If your method is setup, click “Start Method.”  If you have not set up your method, 
review Method Setup. 

 
Figure 6-9 Start Method 

6. Wait a 2 - 5 minutes to allow system to equilibrate to the desired pressure. 
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7. Double-click the UV detector icon to open the UV Input screen. 

 
Figure 6-10 Zero the Detector 

8. Zero the detector by clicking the Zero Detector  button. 

 



 
Method Setup Overview 

 

SFC Prep 350 6-11 Thar Instruments 

MBPR Instructions 

Set the MBPR after 5 minutes of equilibration time at running conditions. 

 

����    CAUTION 
For optimum performance there must be at least 55 b ar of 
manual back pressure on the 1000 mL cyclones during  
collection. 

 

 

 
Figure 6-11 Manual Back Pressure Regulator 

 

This MBPR must be set to 55 bar to achieve optimum conditions.  This will allow for a 
constant minimum 55 bar back pressure on the 1000 mL cyclones while in operation to 
achieve optimum collection conditions. 

 

The most important pressure regarding the MBPR is the pressure on the cyclones while 
collecting, trying to use 0bar on the cyclones will lead to pro duct loss.  
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Test Injections 
NOTE: while doing mixed phase injections the injections can not be closer than 2 minutes apart 

1. Double-click the Injection Module icon to open the Thar Injection Module window. 

 
Figure 6-12 Thar Injection Module 

 

2. Enter the “Injection Volume” and “Injection Duration”. 

3. If using a custom loop size, change “Sample Loop Size” 

4. Change “Sample Conn. Size” to .10 

5. Start the method.  When the system is equilibrated, click the Inject  button on the 
Thar Injection Module screen. 

 

����    NOTE Alternatively an injection can be made by clicking the Make 
Injection button on the UV Input screen. 
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Fraction Collection 

Valve Delay Settings 

There will be “Valve Delay” settings in an Appendix of this manual for your specific unit 

Enter the same valve delay setting for both Start Collecting Conditions and Stop 
Collecting Conditions for the desired flow rate and Co-Solvent (modifier) % 

 

Figure 6-13  Valve Delay Settings 
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Manual Collection  

If you want to collect fractions from a test injection, manual collection is the best option.  
Directions are provided below. 

1. Open the UV Input screen by double-clicking on the UV detector icon on the 
SuperChrom main screen. 

2. When the desired peak displays in the Detector Trend window, turn On each 
cyclone valve by clicking the Collection On/Off toggle icon. 

 
Figure 6-14 Collection Control Parameters 
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3. Alternatively to start collection, select each cyclone manually from the main 
SuperChrom screen. 

4. Right-click on the collection valve and select “Start Collection.” 

 
Figure 6-15 Collection Valve 

5. To stop collection at the end of the peak  

a. On the UV Input screen click the Stop Collection  button or 

b. Turn the Collection switch Off 

c. Alternatively, from the SuperChrom main screen, right-click on the 
collection valve and select “Stop Collection”. 

6. After performing test injections review the “Collection Instructions” (next page). 
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Performing non-stacked injections will allow the user to easily use all the UV detector 
settings found in UV Detector Setup. 

 

 
Figure 6-16 Collection Settings 

 

There are several option to access the Collection Settings: 

• Right click on the detector 

• OR Right click on any of the graphical valves in the SuperChrom screen 

• OR Click “Method” then click on the “Collection” tab 

• Double Click on the UV detector.  At the bottom right of the UV screen there is a 
tab for “Collection Settings” 
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Collection Settings 

 

 
Figure 6-17 UV Input Collection Settings 

Once the “UV Input Collection Settings” window is open the collection settings can be 
modified. 

• Select “Collection Vessel X” 

• Select “Fractions to Collect” 
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Collection Type 

Select the Collection Type.  There are three choices:  mV Threshold, Slope Threshold or 
Timed Collection.  The options are explained on the following pages.  Note:  Changing 
“Collection type” will change the “UV Input Collection Settings” window for each 
Collection Type.   

 

 
Figure 6-18 Select Collection Type 

 

Table 6-1 Collection Settings 

Start collection At ? AUFS Stop collection At ? AUFS 

Time Window Start ? Min Time Window Start ? Min 

Time Window Stop ? Min Time Window Stop ? Min 

Valve Delay  min Valve Delay  min 
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mV Threshold 

This setting collects on the signal coming from the UV detector.  Available settings are 
listed in Table 5-1 (previous page). 

A typical “Start Collection At” and “Stop Collection At” value is 0.10 - 0.20 AUFS. 

 

 
Figure 6-19 mV Threshold Collection 
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mV Threshold Time Windows  

Time windows can be used if there are impurities that might trigger the start of 
collection before the desired peaks.  The System can be stopped for missed time 
window, if desired. 

 

Figure 6-20 mV Threshold Time Windows 

• Time Window Start :  Describes where the computer will start looking for the 
signal strength to start/end collection 

• Time Window Stop :  Describes where the computer will stop looking for the 
desired signal strength and either shut down or stop collecting. 
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Slope Threshold 

This setting will collect on the value of the slope of the signal coming from the UV 
detector.  Available settings are listed in Table 6-2 (this page). 

 

 
Figure 6-21 Slope Threshold Collection 

Table 6-2 Slope Threshold Collection Settings 

Start collection At ? Slope Stop collection At ? Slope 

Time Window Start ? Min Time Window Start ? Min 

Time Window Stop ? Min Time Window Stop ? Min 

Valve Delay  min Valve Delay  min 
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Values for the slope are determined from an existing chromatogram.  To determine the 
slope: 

1. Double-click on the Detector to open up the “UV Input” screen 

2. Find desired chromatogram, and click the cursor button.  

3. Right click on the line that is on the chromatogram. 

 
Figure 6-22 Select Slope 

4. Choose “X, Y_slope” 

5. Determine where the collection should start.   
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Slope Threshold Time Windows 

Time windows can be used if there are impurities that might trigger the start of 
collection before the desired peaks.  The System can be stopped for missed time 
window, if desired. 

 

 

 

• Time Window Start :  Describes where the computer will start looking for the 
Slope to start/end collection. 

• Time Window Stop :  Describes where the computer will stop looking for the 
desired Slope and either shut down or stop collecting. 



 
Method Setup Overview 

 

SFC Prep 350 6-24 Thar Instruments 

Timed Collection 

This setting collects solely on time values entered by the user.   

 

 
Figure 6-23 Timed Collection 

Available settings for timed collection are listed below.  Time Windows are not available 
for Timed Collection. 

Table 6-3 Timed Collection Settings 

Start collection At ? min Stop collection At ? min 

Valve Delay  min Valve Delay  min 
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To determine the time settings: 

1. Double click on the Detector to open up the “UV Input” screen 

2. Find desired chromatogram, and click the cursor button.  

3. Right-click on the line that is on the chromatogram.  (See Figure 5-36, previous 
page.) 

4.  

5. Choose “Delta X.”  Two lines will appear on the “Input Screen.” 

6. Place one of the lines on the Injection Mark. 

7. Place the 2nd line near each desired peak to determine at what times collection is 
required and total run time 



 
Method Setup Overview 

 

SFC Prep 350 6-26 Thar Instruments 

 
Figure 6-24 Collection Times 
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Post Collection 

1. Check the level in the bottles/containers used for collection. 

2. If the bottles are not near capacity, allow the method to continue to run. 

3. Set Co-solvent to 40%. 

4. Manually select collection to each cyclone (used for collection during the 
sequence) and rinse with 50 – 100 mL of solvent. 

5. Click “Stop All” and manually drain each cyclone into the collection 
bottles/container. 

6. Check the level from the level controller in each Fraction Collector to ensure it is  
completely drained. 
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Sequences 

There are two options for setting up a sequence: 

1. Auto Sequencing- performs a set number of injections for each designated 
method 

2. Manually Add Injections 

To create an injection sequence, the following parameters of an existing chromatogram 
must be known: 

• Method • Delay time for solvent equilibration 
• Run duration • Injection volume 
• Start injection option • Wavelength setting for UV detector 
• Injection valve duration  

 

 

Directions for both options are provided on the following pages. 

NOTE: while doing mixed phase injections the injections can not be closer than 2 minutes apart 
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Auto Sequencing  

1. Click the Sequence  button on the main SuperChrom screen. 

 
Figure 6-25 Create Sequence 

2. The Injection Sequence screen displays.  Click the Auto Sequencing  button. 

 
Figure 6-26 Select Auto Sequencing 

3. NOTE: while doing mixed phase injections the injections can not be closer than 2 
minutes apart 
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4. The Sequence Generator window displays. 

 
Figure 6-27 Sequence Generator 

5. A brief description of each field is provided in Table 6-3. 

Table 6-4 Sequence Parameters 

Field Description 

Start On 
System Start  
  
  

Inj. Valve Duration Amount of time  injection valve will be in the “inject” position (seconds) 
Run Duration Length of run after injection (minutes) 
Amount per Inj (mL) Injection volume 
Wavelength Sets UV wavelength 

Methods To Use 
Click Add Method  and select the desired method.  More than one method can be 
selected. 

Injections Per Method Number of injections for selected method 
Method Equil Time Set if desired (minutes) 

Sequence Options 

Append to Current 
Sequence 

Adds the stacked sequence to the existing sequence 
in the “Injection Sequence” box. 

Create New Sequence Creates a new sequence and erases any existing 
sequences in the “Injection Sequence” box 

 

6. Complete all fields, then click Done .  You will return to the Injection Sequence 
screen. 
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7. Select a “When Finished” option on the Injection Sequence screen: 

a. “Maintain Final Conditions”-will maintain conditions after the sequence 
has ended 

b. “Stop System” –will stop system when the sequence has ended 

 
Figure 6-28 Injection Sequence Finished Options 

8. Then click Done . 

9. Review the values in the Injection Sequence screen.  If the values are correct, 
click Done . 
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Manually Create a Sequence 

1. Click the Sequence  button on the main SuperChrom screen. 

 
Figure 6-29 Create Sequence 

2. The Injection Sequence screen displays.  Click the Add Injection  button. 

 
Figure 6-30 Injection Sequence 

3. NOTE: while doing mixed phase injections the injections can not be closer than 2 
minutes apart 
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4. The Add Injection screen displays. 

 
Figure 6-31 Add Injection 

 

Table 6-5 Add Injection Parameters 

Field Description 

Use Method Click the square box to select a method from the method files 
Run Duration Length of the run after injection (minutes) 

Injection Placement 
After Selected Inj. Places injection after highlighted injection on the “Injection 

Sequence” list 

Before Selected Inj. Places injection before highlighted injection on the 
“Injection Sequence” list 

Start Injection On 
Method Start Starts injection process when sequence is started 

Method Equilibration 
Starts injection process when the current method is 
equilibrated 

After Delay of (min.) Delay is typically used for solvent % changes between methods 
Wavelength Sets UV wavelength 
Amount (mL) Sample injection volume 
Inj. Valve Duration Amount of time  injection valve will be in the “inject” position (seconds) 

 

 

5. Complete all fields.  Click Add  until the desired injection number has been 
reached. 

6. Then click Done .  You will return to the Injection Sequence screen. 
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7. Select a “When Finished” option on the Injection Sequence screen: 

a. “Maintain Final Conditions”-will maintain conditions after the sequence 
has ended 

b. “Stop System” –will stop system when the sequence has ended 

 
Figure 6-32 Injection Sequence Finished Options 

8. Then click Done . 

9. Click Done on the Injection Sequence screen to accept any new sequences, 
changed and/or appended sequences 
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Stacked Injection Sequences  
Stacked injections are used to reduce the time to separate a desired amount of sample.  
Typically, stacked injections are used when relatively “clean” samples need to be separated.  As 
such, use of Time Windows is normally discouraged.  Also the optional UV detector settings 
found on page 5-12 are not recommended. 

NOTE: while doing mixed phase injections the injections can not be closer than 2 minutes apart 

Building a Stacked Injection Sequence 

1. Click on the Sequence  button in the SuperChrom main screen to open the 
Injection Sequence window. 

    
Figure 6-33 Select Stacked Inj. Builder 

2. Click on the Stacked Inj. Builder  button. 

3. The Stacked Prep Builder screen displays (next page). 
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Figure 6-34 Stacked Prep Builder 

4. A brief description of each field is provided in Table 6-5.  

Table 6-6 Stacked Prep Builder Parameters 

Field Description 

Inj. Valve Duration Duration sample loop is swept by the mobile phase 
Total Injections Total number of injections 

Sequence Options 
Append to Current Sequence Adds the stacked sequence to the existing 

sequence in the “Injection Sequence” box. 

Create New Sequence Creates a new sequence and erases any existing 
sequences in the “Injection Sequence” box 

Amount per Inj (mL) Injection volume 
Wavelength Sets UV wavelength 
Cycle time Time from beginning of Peak 1 to the end of Peak 2 (minutes) 
Spacing Time between repeated injection cycles (minutes) 
Total Elution Time Total time for one injection (minutes) 
Method Click the Choose Method  button and select the desired method 

 

5. To Create an automated stacked sequence: 

6. In the “Choose Method” box select  the desired method: 
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Figure 6-35 Stacked Injection Instructions 

7. Click “Open” 

8. Enter  the desired  Total Injections 

 

9. Injection duration: xx sec  
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10. To determine the time settings 

11. Double click on the Detector to open up the “UV Input” screen 

12. Find desired chromatogram 

13. Click the  cursor button   

14. Right click on the line that’s on the “Detector Trend” screen to see this: 

  

Figure 6-36 Stacked Injection Cursor Instructions 

 

15. Choose “Delta X” 

  



 
Method Setup Overview 

 

SFC Prep 350 6-39 Thar Instruments 

16. Two lines will appear on the “Detector Trend”  

17. Place one of the lines on the desired beginning  

18. Place the 2nd line near the peak to determine the desired ending 

 

19. Enter Cycle Time : ______min (Time from beginning of peak 
1 to end of peak 2� See Diagram below) 

 

Figure 6-37 Stacked Injection Cycle Time Determinat ion 

 

20. Enter Spacing: XX min  

(Time wanted between repeated injection cycles) 
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21. Enter Total Elution Time XX minutes 

 

 (Total time for one injection � See Diagram below) 

 

Figure 6-38 Total Elution Time Determination 

 

22. Enter Wavelength xx nm  

23. Enter XX mL for Amount per Injection 
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24. Click “Done” 

 

Figure 6-39 Stacked Sequence Parameter Example 

 

25.  Check to make sure the values you entered (Inj Valve Duration, Wavelength, 
total  injections, Inj Amt (mL) are displayed properly in the list of injections.  

26. Select a “When Finished” option on the Injection Sequence screen: 

a. “Maintain Final Conditions”-will maintain conditions after the sequence 
has ended 

b. “Stop System” –will stop system when the sequence has ended 

 
Figure 6-40 Injection Sequence Finished Options 

27. then click “Done”  
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Note: the last injection will be longer to compensate for the stacking.  This 
assures that the last peaks are logged and collected.  

28. Make sure method is still setup for  automated collection… check the values in 
collection settings against the chromatograms generated in the test injections 

29. Click “OK” 

30. Double click on the UV detector, make sure the “Zero Detector 
on Inject” box is not checked 
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����    NOTE 
The last injection will be longer to compensate for  the 
stacking.  This assures that the last peaks are log ged and 
collected. 

 

31. Make sure the method is setup for automated collection when doing stacked 
injections.  From the main SuperChrom screen, click the Method Settings  
button. 

32. Select the Collection tab.  Check “Auto Collection On” and select Start On 
“Injection”.  Then click Done . 

 
Figure 6-41 System Settings 
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Stacked Injection Collection Tips 

• Shut off time windows unless absolutely necessary 

• If a time window is necessary to avoid an impurity, pay very close attention to 
when the time window is set up.  In some cases, the solvent from the next 
injection may change the retention time of the desired peak. 

• Do not start a stacked injection sequence until the desired method is already 
running and equilibrated. 
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Chapter 7  
SFC Prep 350 System 
Maintenance 

Introduction 
This chapter provides maintenance procedures and schedules for the SFC Prep 350 system.  
Periodic preventative maintenance is necessary to maximize performance of the system.  Table 
6-1 summarizes the procedures and recommended frequency. 

Maintenance Schedule 
The maintenance schedule for your SFC Prep 350 system is summarized below.  Procedures for 
specific modules are located in the Operators Manual for the module. 

����    CAUTION 
Many parts on the system are custom made to Thar 
Instruments specifications.  Use of parts from othe r 
vendors may void your warranty. 
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Table 7-1 SFC Prep 350 Maintenance Schedule 

Maintenance Procedure Frequency* Comments 

Pressurizing and leak checking As needed  

Cleaning   

   

Replace CO2 tank washer Every other tank  As needed 

P-350/200 
Pumps 

  

Refer to the P-350/200 High 
Pressure Pump Operations Manual 
(MN-10) for instructions 

Replace piston seals 6 months 

Replace piston backup seals 6 months 

Replace check valves 1 year 

Replace rupture disc As needed 

Replace pump head o-ring As needed 

   

Calibration 1 year Must be performed by qualified 
personnel with certified equipment 

ABPR 

Align the valve  
Refer to the Automated Back 
Pressure Regulator Manual (MN-04) 
for instructions 

Replace seat  

Replace needle  

Replace packing  

   

     

*Performance maintenance at scheduled intervals or as needed. 
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Pressurizing and Leak Checking 
Pressurizing the system and performing a leak check is required when the system is initially 
installed and after each component or column change. 

1. Ensure the valves are in the following positions: 

Valve Position 

MV1 – Prime Closed 

MV1 - System Open 

MV2 Open 

MV3 thru MVX Closed 

MBPR1 Fully CW 
 

2. Open the CO2 supply tank and allow the system to reach tank pressure. 

3. Start at the CO2 supply cylinder and check all fittings in the CO2 flow path for leaks.  Use 
a small amount of leak detector per fitting and a paper towel to catch any excess.  

4. If a leak is detected, remove pressure from the fitting.  Then tighten the fitting a small 
amount at a time and recheck.  Tighten just enough to stop the leak. 

 

 
WARNING 

Remove the pressure from the fitting before tighten ing.  
Tightening or loosening a fitting that is under pre ssure may 
cause the fitting to fail. 

 

����    CAUTION Over-tightening fittings will reduce the seating ab ility of the 
ferrule. 

 

!
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Cleaning Instructions 
A cleaning method can be developed for any process, however, it is the responsibility of the user 
to either have their QC department check to make sure all the solvent coming out of the cyclones 
contains no residual product, or do the QC work themselves.  Thar cannot develop a universal 
cleaning method for proprietary compounds where no material properties are publicly available. 

 

����    NOTE Cleaning is the responsibility of the user. 

 

Collection Vessel Cleaning 

1. Set Co-solvent to 40 - 100%. 

2. Start Method. 

3. Select each cyclone manually from the main SuperChrom screen.  Right-click on 
the collection valve and select “Start Collection”. 

 
Figure 7-1 Select Collection Valve 
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4. Or Turn On each cyclone valve from the “UV Input” Screen. 

 
Figure 7-2 Turn on Collection 

5. After 50 to 100 mL of co-solvent has run through the cyclone, click Stop 
Collection  or turn the Collection switch to “Off”. 

6. Click “Stop All” and manually drain each cyclone into the collection 
bottles/container. 

7. Check the level from the level controller in each Fraction Collector to ensure it is  
completely drained. 
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Injection Module Cleaning 

1. Place the “Sample tubing” on the Injection module in the waste beaker and rinse 
the outside of the tubing with methanol. 

2. Click Wash in the Injection Module window.  Ensure a response in the hardware 
and the software (a wash includes 2 full aspirations of the syringe). 

3. To double check the wash 

a. Start a method 

b. Take the “Sample Tubing” out of the waste beaker and click Inject  this 
will inject any solvent left in the sample tubing from the wash. 

c. View the UV data from this injection to determine if there is any residual 
product in the sample line. 
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Appendix I  
SFC Prep 350 System Technical Specifications 
 

Physical  and Environmental   Comments 

   

Dimensions  
(width x depth x 
height) 

System 107 x 92 x 135 cm (42 x 
36 x 53 in) 

 

Water bath 40 x 43 x 63 cm (16 x 17 x 
25 in) 

 

Computer 20 x 43 x 43 cm (8 x 17 x 
17 in) 

 

Computer 
monitor 

43 x 41 x 43 cm (17 x 16 x 
17 in) 

 

Weight System 136 kg (300 lb)  

Water bath 65 kg (145 lb)  

Computer 20 kg (45 lb)  
Computer 
monitor 

20 kg (25 lb)  

Operating temperature  Optimal:  18 - 27°C (65 - 
81°F) 

Relative humidity  Optimal:  25 – 60% 

Maximum oven temperature setting  80°C 

   

   

 

 

Operational   

Maximum pressure 400 bar 

Maximum operating temperature 80°C 

Maximum heat rate ~6°C/min 

Temperature accuracy ± 0.5°C 
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General   

Sound pressure level < 70 dB 

Working temperature 5 - 40°C (41 - 104°F) 

Storage temperature -20 to +60°C (-13 to +140°F) 

Humidity 20 – 80% RH 

IP rating IP22 

Duty rating Continuous 

Pollution degree 2 

Wetted parts SS316, SS304, GFPM 

 

 

Programming   

Control User customizable PI 

 

Electrical   

Power requirements 90 – 179 VAC; 50/60 Hz  

System - 28amps 

Computer and Monitor – 2amps 

 180 – 255 VAC; 50/60 Hz 

System - 18amps 

Computer and Monitor – 2amps 

Fuses P-350 

 

 

P-200    

 

 

 

Six-Zone Heat 
Controller 

 

ABPR 

 

 

Injection 
Module 

 

Collection 
Module 

00467 Fuse, 10A SlowBlo (110V Units) 

00555 Fuse, 10A SlowBlo (220V Units) 

00467 Fuse, 10A SlowBlo (110V Units) 

00555 Fuse, 10A SlowBlo (220V Units) 

04527 Fuse, 2.0Amp 3AG Fast Blow 

04526 Fuse, 1.0Amp 5 X 20mm Fast Blow 

 

04334 Fuse, 1.6Amp 5 X 20MM Slow Blow (220V units) 

00382 Fuse, 3Amp, 1/4" X 1-1/4' GLS Slow Blow (110 V units)

 

04334 Fuse, 1.6Amp 5 X 20MM Slow Blow (220V units) 

00382 Fuse, 3Amp, 1/4" X 1-1/4' GLS Slow Blow (110 V units)

 

04334 Fuse, 1.6Amp 5 X 20MM Slow Blow (220V units) 

00382 Fuse, 3Amp, 1/4" X 1-1/4' GLS Slow Blow (110 V units)
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UV detector 

 

04334  Fuses(2), 1.6Amp 5 X 20MM Slow Blow (220V 
units) 

04334 Fuse(1), 1.6Amp 5 X 20MM Slow Blow (110V units) 

 

 

   

 All fuses UL- listed and CSA-certified 

Grounding-system Requires properly grounded receptacle 

 
*Normal operating current.  High inrush currents are possible at power on. 

 
 
Communication   

  

Inputs  

Serial communication port RS232C (9600 baud, 8 data bits, odd parity, 1 stop bit) 

Rocketport (9600 baud, 8 data bits, odd parity, 1 stop bit) 

 

PC control Microsoft Windows XP 
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Appendix II  
SFC Prep 350 System Settings 

Pump Settings and Operational Ranges 

Operational Ranges 

Operating pressure range: 55 – 400 bar 
Total system flow rate: 100 - 350 g/min 
CO2 flow rate: 40 – 350 g/min 
Modifier flow rate: 20 – 200 mL/min 
 

CO2 Pump (P350) Settings 

1. Right click on the CO2 pump. 

2. Click on CO2 Pump Settings. 

 
Figure I-A Select CO2 Pump Settings 
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3. Check the settings against the following table. 

Table I-A CO 2 Pump (P350) Settings 

Attenuation Factor 1 

Equation Factor 10 

Proportional Constant 1 

Integral Constant 2 

Integral Max 15000 

Derivative Constant 1 

PID Threshold 0 

Control By Flow 

 

Co-Solvent Pump (P200) Settings 

1. Right click on the Co-Solvent pump and select Co-Solvent Pump Settings. 

 
Figure I-B Select Co-Solvent Pump Settings 
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2. Check the settings against the following table. 

Table I-B Co-Solvent Pump (P200) Settings 

Attenuation Factor 1 

Equation Factor 12 

Proportional Constant 2 

Integral Constant 1 

Integral Max 8000 

Derivative Constant 1 

PID Threshold 1000 

Control By Flow 

 

Heat Exchanger Settings 

1. Right click on the Heat Exchanger and select Heater Controller Settings. 

 
Figure I-C Select Heater Controller Settings 
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2. Change each zone at the top of the screen in Zone Settings>>Select Zone. 

 
Figure I-D Zone Settings 

3. Compare each zone to the following tables. 

Table I-C Zone 1 Settings 

Zone Name HE 2   

Temp Set Point 35 Alarm Set Point 60 

Max. Temp 60 Max. Alarm 60 

Cycle Time 5 Dead Band 0 

Proportional 299 Integral 349 

Derivative 87 Upper Integral B 299 

Lower Integral B 299 SSR Slope Min 0 

SSR Slope Max 100 SSR Slope 1000 

TC Type J   

 

Table I-D Zone 2 Settings 

Zone Name Mobile Phase Temp   

Temp Set Point 35 Alarm Set Point 60 

Max. Temp 60 Max. Alarm 60 

Cycle Time 5 Dead Band 0 

Proportional 299 Integral 349 

Derivative 87 Upper Integral B 299 

Lower Integral B 299 SSR Slope Min 0 

SSR Slope Max 100 SSR Slope 1000 

TC Type J   
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Table I-E Zone 3 Settings 

Zone Name HE 3   

Temp Set Point 35 Alarm Set Point 60 

Max. Temp 60 Max. Alarm 60 

Cycle Time 5 Dead Band 0 

Proportional 425 Integral 33 

Derivative 1 Upper Integral B 425 

Lower Integral B 425 SSR Slope Min 0 

SSR Slope Max 100 SSR Slope 1000 

TC Type J   

Table I-F Zone 4 Settings 

Zone Name 

NONE OR HE4 if 
system has been 
upgraded to modifier 
stream injection 

  

Temp Set Point 35 Alarm Set Point 60 

Max. Temp 60 Max. Alarm 60 

Cycle Time 5 Dead Band 0 

Proportional 553 Integral 607 

Derivative 151 Upper Integral B 553 

Lower Integral B 553 SSR Slope Min 0 

SSR Slope Max 100 SSR Slope 1000 

TC Type 

None OR J if system 
has been upgraded to 
modifier stream 
injection 

  

Table I-G Zone 5 Settings 

Zone Name NONE   

Temp Set Point 35 Alarm Set Point 60 

Max. Temp 60 Max. Alarm 60 

Cycle Time 5 Dead Band 0 

Proportional 553 Integral 607 

Derivative 151 Upper Integral B 553 

Lower Integral B 553 SSR Slope Min 0 

SSR Slope Max 100 SSR Slope 1000 

TC Type NONE   
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Table I-H Zone 6 Settings 

Zone Name NONE   

Temp Set Point 35 Alarm Set Point 60 

Max. Temp 60 Max. Alarm 60 

Cycle Time 5 Dead Band 0 

Proportional 553 Integral 607 

Derivative 151 Upper Integral B 553 

Lower Integral B 553 SSR Slope Min 0 

SSR Slope Max 100 SSR Slope 1000 

TC Type NONE   

 

ABPR Settings 

1. Right click on the ABPR and select ABPR Settings. 

 
Figure I-E ABPR Settings 
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2. Compare the settings on the “Pressure Regulator settings” to the table below. 

 
Figure I-F Pressure Regulator Settings 

 

Table I-I Pressure Regulator Settings 

Pressure Set Point [user specified] Attention Factor 1 

Pressure Alarm 410 Proportional Constant 300 

Valve Heater Set point 30 Integral Constant 500 

Ext. Heater Set Point 0 Output Max 2500 

Ext. Temp Alarm 100 Derivative Constant 560 
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Appendix III  
Waste Electrical and Electronic Equipment 
(WEEE) Directive

In conformance with European Union Directive 2002/96/EC on Waste Electrical and Electronic
Equipment (WEEE), this device may not be disposed of in domestic waste.

 

 

 

 

This disposal requirement also applies to countries outside of the EU, per their specific 
requirements. 

Please dispose of this product in accordance with local regulations at the collecting point 
specified for electrical and electronic equipment.  

If you have any questions, please contact the responsible authority or the distributor from which 
you purchased this device. 

Should this device be passed on to other parties (for private or professional use), the content of 
this regulation must also be related.

Thank you for your contribution to environmental protection.

XII Thar Instrument

Waste Electrical and Electronic Equipment 
(WEEE) Directive  

In conformance with European Union Directive 2002/96/EC on Waste Electrical and Electronic
Equipment (WEEE), this device may not be disposed of in domestic waste. 

 

This disposal requirement also applies to countries outside of the EU, per their specific 

Please dispose of this product in accordance with local regulations at the collecting point 
specified for electrical and electronic equipment.   

If you have any questions, please contact the responsible authority or the distributor from which 

Should this device be passed on to other parties (for private or professional use), the content of 
this regulation must also be related. 

Thank you for your contribution to environmental protection. 

Appendices 
 

Thar Instruments 

Waste Electrical and Electronic Equipment 

In conformance with European Union Directive 2002/96/EC on Waste Electrical and Electronic 

This disposal requirement also applies to countries outside of the EU, per their specific 

Please dispose of this product in accordance with local regulations at the collecting point 

If you have any questions, please contact the responsible authority or the distributor from which 

Should this device be passed on to other parties (for private or professional use), the content of 
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Appendix IV  
Consumables and Spare Parts 
 

Module Part number Description Quantity 

Base System 

01075 Seal, 75-100 mL 1.17”VID, Polyimide 2 

06254 Disc, 1500 psi 1/4” MNPT Rupture 1 

01070 Seal, 3-50 mL, Polyimide, Med spring (EGC) 3 

P-350 Pump 

04093 Seal, Piston Spring 2 

04133 PEEK Seal Backup  2 

02805 Disc, 6000 psi 3/16" 72*F Rupture 3/8" OD 3 

01377 Check Valve, 3/8" Dia 10,000 Psi  4 

01794 Check Valve housing 4 

04263 Piston Assembly 2 

P-200 

01033 Seal, Piston Spring  

01032 PEEK Seal Backup   

02805 Disc, 6000 psi 3/16" 72*F Rupture 3/8" OD  

01377 Check Valve, 3/8" Dia 10,000 Psi   

01794 Check Valve housing  

00754 Piston Assembly  

UV Detector 

05944 Fitting, 1/16” Short Rheodyne SS 1 

05945 Fitting, 1/16" Lite-Touch Ferrule (Gilson Cell) 2 

05946 Fitting, 1/16" 10-32 Male Nut (Gilson Cell) 1 

06854 Cell Assy, SFC Prep Flow 1 

06186 Lamp, Uv - For Gilson Detector 1 

06384 Lamp, Vis - For Gilson Detector 1 

ABPR-200 
04497 Seat, PEEK for 04062 Micrometering 1 

06409 Kit, Rebuild for Micrometering 2 

Injection Module 

06828 Kit, Rebuild for Inj & Col Module 2 Pos Valve 2 

06830 Stator for Inj & Col Module 2 Pos Valve 1 

06721 Syringe, 25 ML XLP 1 

06676 Solenoid Valve Assy, 24 VDC, 250 psi, 3-way FC 1 

Fraction 
Collection Module 

06831 Kit, Rebuild for Collection Module 12 Pos Valve 1 

06832 Stator for Collection Module 12 Pos Valve 1 

06828 Kit, Rebuild for Inj & Col Module 2 Pos Valve 1 

06830 Stator for Inj & Col Module 2 Pos Valve 1 
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Appendix IV  
Declaration of Conformity 
 



Appendices 
 

SFC Prep 350 XV Thar Instruments 

 



Appendices 
 

SFC Prep 350 XVI Thar Instruments 

 

 



Index 
 

SFC Prep 350 XVII Thar Instruments 

Index 
A 

ABPR 
Settings .......................................................... X 

Additives ....................................................... 1-10 
Alarms ............................................................. 1-4 
Auto Sequencing ........................................... 6-29 

B 

Bulk fluid ......................................................... 1-8 

C 

Circulating bath ............................................... 2-4 
Cleaning .......................................................... 7-4 
CO2 Pump ....................................................... 2-3 

Settings .......................................................... V 
Collection 

Bottles ......................................................... 5-2 
Containers ................................................. 1-12 
Instructions ................................................ 6-13 
Post collection ........................................... 6-27 
Settings ..................................................... 6-17 
Timed ........................................................ 6-24 
Type .......................................................... 6-18 
Vessels ...................................................... 5-23 

Collection vessel 
Cleaning ...................................................... 7-4 

Columns 
Installation ................................................. 5-14 

Consumables .................................................. XIII 
Co-Solvent ...................................................... 1-9 
Co-Solvent Pump ............................................ 2-4 

Prime ......................................................... 5-10 
Settings ......................................................... VI 

Co-Solvents .................................................. 2-10 
Customer support .............................................. iv 

D 

Data file settings ............................................. 6-7 
Declaration of conformity ................................ 1-1 
Depressurize ................................................. 5-15 

F 

Field service ....................................................... iv 
Flammability warning ...................................... 1-5 
Fluids not recommended............................... 1-11 
Fraction Collection ........................................ 6-13 
Fraction Collection Module.............................. 2-4 

G 

Grounding ....................................................... 2-8 

H 

Heat exchanger ............................................... 2-4 
Heat Exchanger 

Settings ........................................................ VII 

I 

Icon definitions ................................................... iv 
Injection module 

Cleaning ...................................................... 7-6 
Priming-in mixed phase ............................. 5-20 
Priming-in modifier stream ......................... 5-21 
Settings ..................................................... 5-19 
Startup-in mixed phase.............................. 5-21 

Injection Module .............................................. 2-4 
Installation ....................................................... 2-5 

L 

Leak checking ............................................... 5-18 
Level Controller Drain Settings...................... 5-26 

M 

Maintenance schedule .................................... 7-1 
Manual BPR .................................................. 5-22 
Manual Collection .......................................... 6-14 
Mass flow meter .............................................. 2-4 
MBPR Manual Back Pressure Regulator ...... 6-11 
Method 

Settings ....................................................... 6-1 
Startup ......................................................... 6-9 

Mobile phase solvents ............................ 1-8, 2-10 
Modifier ........................................... See Co-solvent 
mV Threshold Collection ............................... 6-19 

O 

Operating voltage ............................................ 1-6 

P 

Power 
Supply ......................................................... 2-8 

Pump 
Operational ranges ......................................... V 



Index 
 

SFC Prep 350 XVIII Thar Instruments 

S 

Safety 
Sensors ....................................................... 1-4 

Safety features ................................................ 1-3 
Sample 

Connection size ......................................... 5-20 
Sequence 

Manual ...................................................... 6-32 
Sequences .................................................... 6-28 
Shipping .......................................................... 1-2 
Shutdown ...................................................... 5-27 

Long term .................................................. 5-28 
Short term ................................................. 5-27 

Slope Threshold Collection ........................... 6-21 
Spare parts ..................................................... XIII 
Stacked injection ........................................... 6-44 
Stacked injection Sequences ........................ 6-35 
Startup ............................................................ 5-1 

Method ........................................................ 6-9 
Static mixer ..................................................... 2-4 
Storage ........................................................... 1-2 
SuperChrom .................................................... 5-3 

T 

Test Injection 

Collection ................................................... 6-14 
Test Injections ............................................... 6-12 
Time Windows 

mV Collection ............................................ 6-20 
Slope Threshold Collection ........................ 6-23 

U 

Using this manual ............................................... iv 
UV Detector .................................................... 2-4 

Setup ........................................................... 5-5 

V 

Valve Delay 
Settings for Collection ............................... 6-13 

Venting .......................................................... 2-11 

W 

Water bath ...................................................... 5-2 

Z 

Zone 
Settings ....................................................... VIII 

 


